<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Information</td>
<td>1</td>
</tr>
<tr>
<td>Preface</td>
<td>2</td>
</tr>
<tr>
<td>Principles of time stamping</td>
<td>3</td>
</tr>
<tr>
<td>Layout</td>
<td>4</td>
</tr>
<tr>
<td>Systems and components</td>
<td>5</td>
</tr>
<tr>
<td>Configuring time stamping</td>
<td>6</td>
</tr>
<tr>
<td>AS process control messages for time stamping faults</td>
<td>7</td>
</tr>
</tbody>
</table>

Valid for PCS 7 as of V8.2
Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

**DANGER**

indicates that death or severe personal injury will result if proper precautions are not taken.

**WARNING**

indicates that death or severe personal injury may result if proper precautions are not taken.

**CAUTION**

indicates that minor personal injury can result if proper precautions are not taken.

**NOTICE**

indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

**WARNING**

Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of contents

1. **Security information** .............................................................................................................................. 5  
2. **Preface** .................................................................................................................................................. 7  
3. **Principles of time stamping** .................................................................................................................. 11  
   3.1 Principles of high-precision time stamping ......................................................................................... 11  
   3.2 Time stamping of signal changes ....................................................................................................... 12  
   3.3 Sequence of time stamping .................................................................................................................. 13  
   3.4 Sequence of time stamping in the interface module ............................................................................ 15  
4. **Layout** .................................................................................................................................................. 19  
   4.1 Plant design and configuration ............................................................................................................ 19  
   4.2 Hardware layout ................................................................................................................................. 20  
   4.3 Special features of the interface module ............................................................................................ 22  
   4.4 High-precision time stamping with 1 ms accuracy ............................................................................. 23  
5. **Systems and components** .................................................................................................................... 25  
   5.1 Overview: Systems and components .................................................................................................. 25  
   5.2 SIMATIC station .................................................................................................................................... 25  
   5.3 Communication modules ................................................................................................................... 26  
   5.4 Distributed I/O ..................................................................................................................................... 26  
   5.5 IMDRV_TS block ................................................................................................................................. 28  
   5.6 EventTS block ....................................................................................................................................... 29  
   5.7 Time master .......................................................................................................................................... 30  
6. **Configuring time stamping** .................................................................................................................... 31  
   6.1 Overview of configuration steps ......................................................................................................... 31  
   6.2 Configuring the networks ..................................................................................................................... 32  
   6.2.1 Configuring the networks ............................................................................................................... 32  
   6.2.2 How to configure the CP 443-1 (Industrial Ethernet) .................................................................. 32  
   6.2.3 How to assign parameters for the integrated Ethernet connection for a CPU 41x .................... 34  
   6.2.4 How to configure the CP 443-5 Extended ..................................................................................... 35  
   6.2.5 Rules for configuring the time interval ............................................................................................ 36  
   6.2.6 How to configure the PROFIBUS connection of the CPU ............................................................. 37  
   6.3 Configuring the ET 200 station (ET 200M and ET 200iSP) ................................................................. 40  
   6.3.1 Setting options of the ET 200 station ............................................................................................... 40  
   6.3.2 How to configure the interface module .......................................................................................... 40  
   6.3.3 Examples of settings on interface module IM 153-2 .................................................................... 43  
   6.3.4 How to configure the SM 321 digital input module ...................................................................... 44  
   6.3.5 Examples of settings on digital input module SM 321 ................................................................. 46  

High-precision time stamping (V8.2)  
Function Manual, 03/2016, A5E36186939-AA
Siemens provides products and solutions with industrial security functions that support the secure operation of plants, solutions, machines, equipment and/or networks. They are important components in a holistic industrial security concept. With this in mind, Siemens’ products and solutions undergo continuous development. Siemens recommends strongly that you regularly check for product updates.

For the secure operation of Siemens products and solutions, it is necessary to take suitable preventive action (e.g. cell protection concept) and integrate each component into a holistic, state-of-the-art industrial security concept. Third-party products that may be in use should also be considered. For more information about industrial security, visit http://www.siemens.com/industrialsecurity

To stay informed about product updates as they occur, sign up for a product-specific newsletter. For more information, visit http://support.automation.siemens.com.
Purpose of this documentation

This documentation provides you with a full overview of the topics relating to the use of high-precision time stamping:

- Required components
- Interaction of the components
- Configuration of the components

The first section gives you an overview of the option and use cases for high-precision time stamping and is intended for the following readership:

- Future users of SIMATIC PCS 7
- Persons responsible for deciding on the use of a control system
- Sales personnel and system configuration engineers either within Siemens or belonging to other companies

The subsequent sections show the configuration and parameter assignments for high-precision time stamping and is intended for persons involved in the following occupations:

- Conceptual design of PCS 7 solutions
- Device and system programming
- Configuration and commissioning
- Servicing
Options for accessing PCS 7 documentation

The documentation required for PCS 7 includes the following types:

- **PCS 7 Readme**
  The readme file is available in two versions:
  - **PCS 7 Readme (offline)**
    This version is installed by PCS 7 Setup. The file only contains general information and links to documents on the Internet.
  - **PCS 7 Readme (online)**
    This version contains all information on the installation and use of PCS 7 in the format which is already familiar to you. The file is only available on the Internet to keep it always up-to-date

  **Note**
  The information provided in the *PCS 7 Readme* (online) on the Internet takes precedence over all other PCS 7 documentation.
  Read this *PCS 7 Readme* carefully, because it contains important information and amendments on PCS 7.

- **PCS 7 System Documentation**
  System documentation contains information that covers several products, such as configuration manuals and Getting Started manuals. This documentation serves as a guideline for the overall system and explains the interaction between the individual hardware and software components.
  Note the information on "PCS 7 Documentation Portal Setup" in the product overview *Process Control System PCS 7; PCS 7 - Documentation; Section "Options for accessing the documentation"*

- **PCS 7 Product Documentation**
  Product documentation contains information about special hardware and software components. The individual documents provide detailed information on the specific component.
  Full versions of the documentation are available from the "Technical Documentation SIMATIC PCS 7" website: [http://www.siemens.com/pcs7-documentation](http://www.siemens.com/pcs7-documentation)
  You can find additional information in the product overview *Process Control System PCS 7; PCS 7 - Documentation; Section "Options for accessing the documentation"*.

**Required basic knowledge**

General knowledge in the area of automation engineering and basic knowledge of PCS 7 is required to understand this documentation. It is also assumed that the reader knows how to use computers or other equipment similar to PCs (such as programming devices) with the Windows operating system.

The configuration manuals and the Getting Started documentation for PCS 7 will provide you with basic information regarding the use of PCS 7.
Conventions

In this documentation, the names of elements in the software interface are specified in the language of this documentation. If you have installed a multi-language package for the operating system, some of the designations will be displayed in the base language of the operating system after a language switch and will, therefore, differ from the designations used in the documentation.

If you are using the Windows 10 operating system, you can find the Siemens SIMATIC programs in the "Start" menu under All apps > Siemens Automation.

Changes compared to the previous version

Below you will find an overview of the most important changes in the documentation compared to the previous version:

As of PCS 7 V8.1

- Use of the CPU 410-5H

PCS 7 V7.1 or higher

- The IMDRV_TS and MSG_TS blocks replace the IM_DRV in the PCS 7 Library. Message texts are retained following a future update of the library.
- High-precision time stamping using blocks from the PCS 7 Advanced Process Library (APL)
- High-precision time stamping with redundant signal acquisition
- You will find information about time synchronization in the Process Control System PCS 7; Time Synchronization function manual.
3.1 Principles of high-precision time stamping

Introduction

This documentation describes the time stamping function for digital input signals. Users can activate time stamping in their system configuration and display the time information in their monitoring system.

Definition

The following is meant when referring to time stamping in this documentation:

The assignment of time information with a high degree of accuracy about the state changes of an acquired process signal.

The detection of changes in digital input signal states and the assignment of time information are performed by SIMATIC components.

Application

Possible applications for high-precision time stamping are:

- Accurately-timed detection of problems in process-related equipment. Time stamping enables you to explicitly identify signals that indicate the cause of the failure of a process unit.
- Analysis of system-wide interrelationships
- Detection and reporting of the sequence of time-critical signal changes
- Time-precise acquisition of signal changes in fail-safe devices

Requirement

The time must be synchronized on all the devices belonging to the system. The devices are connected to a highly accurate time master for this purpose. Usage of SICLOCK TC 400 is recommended. Synchronization interval or poll interval must be ≤ 10 seconds.
3.2 Time stamping of signal changes

Precision

The following applies to high-precision time stamping:

- If process signals are acquired from a separate PROFIBUS DP master systems and results arrive simultaneously at the input module, the time stamps of the resulting messages in the HMI system differ by maximum x milliseconds (see table below). The achievable precision depends on the I/O modules used.
- The signals receive a time stamp regardless of whether the PROFIBUS DP master systems are located in one or more SIMATIC 400 stations.

<table>
<thead>
<tr>
<th>Achievable precision</th>
<th>I/O</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 ms</td>
<td>ET 200M</td>
<td>With ET 200M, you can acquire signal changes with selected digital input modules with an accuracy of 1 ms. You can find additional information about this in the section &quot;High-precision time stamping with 1 ms accuracy (Page 23)&quot;.</td>
</tr>
<tr>
<td>10 ms</td>
<td>ET 200M</td>
<td>With ET 200M, you can acquire signal changes with selected digital input modules with an accuracy of 10 ms.</td>
</tr>
<tr>
<td>20 ms</td>
<td>ET 200iSP</td>
<td>With ET 200iSP, you can acquire signal changes with selected digital input modules with an accuracy of 20 ms.</td>
</tr>
<tr>
<td>20 ms</td>
<td>ET 200M</td>
<td>During fail-safe signal acquisition with ET 200M, you can acquire signal changes with selected digital input modules with an accuracy of 20 ms.</td>
</tr>
</tbody>
</table>

Resolution

The displayed resolution of the time is 1 ms (regardless of the precision).

Advantage

The high-precision time stamping does not depend on cycle times.

Property

The high-precision time stamping can only be used for digital input modules.

Additional information

For additional information about released digital input modules, refer to the section "Systems and components (Page 25)".

3.2 Time stamping of signal changes

Time-precise acquisition

The use of time stamps makes it easier to analyze the causes of malfunction.
Example

If a boiler used to produce steam fails, this event causes a surge of messages:

- The temperature and pressure fall below a specified limit value, the flame monitor responds, the next plant unit signals "steam low", etc.
- To determine the actual cause of the failure, the first message in this surge of messages must be identified (for example, "gas pressure too low”).
- Following the failure of a plant unit, a large number of messages will arrive at the monitoring stations within the same second. A resolution of 1 second for the message time is inadequate. You can use time stamping to selectively detect the signals that can potentially lead the shutdown of the boiler with a resolution in the millisecond range. This option gives the operator the opportunity of finding the cause of the event.

Plant-Wide Interrelationships

A further aspect of 10 ms time stamping is the determination of interrelationships between units in a plant.

Example

High-precision time stamping is implemented throughout the plant. Relevant signals of the individual automation systems configured with PCS 7 can be compared (for example, the signals of a filling station with the signals of a dosing station originating from another AS).

By comparing the time stamps of relevant signals throughout the plant, a momentary quality impairment in a unit can be traced to an event in another unit.

3.3 Sequence of time stamping

Description

The following table describes the time stamping sequence.

The digital inputs of a module in the distributed I/O station (ET 200M, ET 200iSP) are monitored for signal transitions.

<table>
<thead>
<tr>
<th>Step</th>
<th>Who/Where?</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IM</td>
<td>The interface module IM stores the signal state change.</td>
</tr>
</tbody>
</table>
| 2    | IM         | The interface module IM stores the information about an "incoming event" with the current time in a message list (in the IM). Features:  
  - The time resolution of the time stamping is 1 ms.  
  - Special messages are also saved in the message list (events influencing message processing).  
  - An IM stores up to 240 messages. These messages are processed in data records. A data record contains a maximum of 20 messages. |
3.3 Sequence of time stamping

<table>
<thead>
<tr>
<th>Step</th>
<th>Who/Where?</th>
<th>What?</th>
</tr>
</thead>
</table>
| 3    | IM         | The interface module IM triggers a hardware interrupt on the DP master (for example, SIMATIC station S7-4xx) if one of the following events occurs:  
• A message list (data record) in the IM is full.  
• There is at least one message in a message list after 1 second. |
| 4    | CPU        | The CPU reads the reaction to the process alarm (OB 4x) from the data record. |
| 5    | IMDRV_TS   | The driver block IMDRV_TS reads the data records of the interface module and transfers the information to signal the APL block Pcs7DiIT. The information of the input signal is stored temporarily in the block Pcs7DiIT.  
The message texts are saved to the signaling block by default (you can find additional information on this in the "AS process control messages for time stamp faults" section). |
| 6    | EventTS; Event16TS | This APL blocks reads the time stamp via the Pcs7DiIT block from the output of IMDRV_TS. The EventTS or Event16TS block sends the message to the operator station. The message text depends on the configuration (see the paragraph "Additional information").  
The configuration in HW Config defines which signal transition 0 > 1 or 1 > 0 is to be reported as "INCOMING". The "OUTGOING" message is generated when the state reported by "INCOMING" changes.  
The signals with a time stamp are entered without gaps and in ascending chronological order in the message list of the operator station. |
| 7    | Synchronization | All the operator stations and SIMATIC stations used in the system must be supplied with the same time:  
• The time master regulates the time synchronization for time stamping.  
• Various time masters are available, for example:  
  – "SICLOCK TC 400"  
  – "Real-time transmitter for Industrial Ethernet" or any other time master that provides an accurate timesignal like SICLOCK TC 400. |

Additional information

- Section "How to configure messages with blocks of the PCS 7 Advanced Process Library (APL) (Page 58)"
- Operating Instructions SIMATIC; Distributed I/O Device ET 200M
- Operating Instructions SIMATIC; Distributed I/O Device ET 200iSP
3.4 Sequence of time stamping in the interface module

Principle

The figure below shows how signal transitions are time stamped in the interface module (IM 153-2, IM 152-1).
3.4 Sequence of time stamping in the interface module

Startup of the ET 200 station is complete. The interface module is ready to exchange data with the DP master.

Are there suitable time stamp parameters for the configuration?

Yes

Is the clock in the interface module set?

Yes

Generate startup data: reading of statuses of configured digital inputs; hardware interrupt on DP master, so that message buffer is read.

Monitor digital inputs: in case of change, generation of the message and entry in the message buffer.

Diagnostics of the time-of-day frame: In the case of failure or time jump greater than permitted tolerance, generation of a special message and entry in the message buffer.

Hardware interrupt on DP master, so that message buffer is read.

No

Error message on DP master; digital input signals are not time-stamped. "Normal" data exchange with DP master is not affected by this.

No

Current time

Clock in the interface module

Set the clock of the interface module

Time will be set to 01/01/1984; 00:00

Redundancy?
**Note**

**Startup synchronization**

A time stamp with the value "01.01.1984" will be sent if the interface module is not time synchronized during startup. The events are correctly assigned a time stamp after the first synchronisation with the CPU/CP following the automatic configuration (synchronization) by the CPU.
Principles of time stamping

3.4 Sequence of time stamping in the interface module
4.1 Plant design and configuration

The following rules apply to the configuration of high-precision time stamps in addition to the configuration rules of PCS 7 (see documentation SIMATIC; Process Control System PCS 7; Engineering System).

Introduction

The following rules are intended for the optimization of the plant with regard to high-precision time stamps.

Rules

- Configure time stamping for relevant signals only in SIMATIC stations. High precision time stamps are used for error analysis and should not be employed for process control. You can find additional information about this in the section "Principles of high-precision time stamping (Page 11)".

- High-precision time stamping can only be configured for digital inputs.

- Check the applicability of the modules. You can find additional information about this in the section “Systems and components (Page 25)".

- When planning your system and during configuration, ensure that the signals to be acquired are distributed uniformly throughout the system.

- Configure a maximum of 8 modules that can process data records for each PROFIBUS master system (IM, CP, FM).

- Configure the ET 200 stations as uniform as possible. The measurement results will be comparable with a uniform configuration. Examples:
  - Physical - cables and encoders (switches, sensors, etc.)
  - Hardware - module types
  - Configuration - for example, identical delay times for the inputs

- Configure only digital inputs in these ET 200 stations.
Do not configure technological functions in these ET 200 stations; this omission will assure the deterministic characteristic of the plant.

Plant-specific configuration:
Design the assembly of an ET 200 station in such a way that, taken together, the digital inputs used will generate a limited number of signal changes for the plant even in critical situations. Individual defective encoders or massive switching operations (shutdown of a plant, for example) often generate a large number of signal changes. PCS 7 ensures that the cause of the event can be located in these situations. A transient buffer overflow that can occur with a plant failure is not critical, because the error messages causing it are recorded in the archive.

4.2 Hardware layout

Introduction
You use the distributed I/O based on ET 200M or ET 200iSP to acquire the signals.
This section provides an example of a hardware configuration needed for time stamping.

Example system with time stamping
The following figure shows an example of a system configuration with time stamping.
Example plant with time stamping in the fault-tolerant automation system

You can also use the time stamping function together with an S7-400H and distributed I/O:

- With an ET 200M, you can connect to a redundant PROFIBUS DP (redundant interconnection) and create a redundant configuration even to the sensor (fully redundant distributed I/O).
- With an ET 200iSP, you can connect to a redundant PROFIBUS DP (redundant interconnection).

Below you will see an example of a system using ET 200M.

**Note**

**Redundant signal acquisition**

The required resources depend on the number of inputs, not the number of redundantly acquired signals.

**Additional information**

- You will find information about time synchronization in the *Process Control System PCS 7; PCS 7 Time Synchronization* function manual.
- You can find information about the IM 153-2 interface module in the manual *Distributed I/O Device ET 200M.*
You can find information about the IM 152-1 interface module in the manual Distributed I/O Device ET 200iSP.

You can find information about the redundant configuration of a distributed I/O in PCS 7 in the following documentation:

- Manual Process Control System PCS 7; Fault-tolerant Process Control Systems
- Manual Programmable Controller S7-400H, Fault-Tolerant Systems

### 4.3 Special features of the interface module

**Introduction**

PCS 7 ensures that the cause of an event can be located in critical situations. This statement also applies if the message buffer of an interface module (IM 153-2, IM 152-1) becomes overloaded due to a signal surge and too many signals constantly being reported. Read the section "Plant design and configuration (Page 19)". Constant overload can result in the loss of messages.

**Message surge**

When "unusual" events occur (for example, failure of a plant unit), signal transitions can occur almost simultaneously.

This behavior can be explained by analyzing the technological interrelationships.

**Example**

The frequency of signal transitions in a system can be projected as follows:

- On average, approximately 2% of the signals change per second.
- In the worst case (such as the failure of a plant unit), approximately 30% of the signals change state per second.

**Message loss**

If all the time-stamped signals of a system are collected on one ET 200 station, messages can be lost on the relevant interface module when "unusual" events occur. The message loss is displayed according to the cause using AS process control messages (you can find additional information in the "AS process control messages for time stamping faults (Page 61)" section).

**Example for 10 ms time stamping**
A system with ET 200M has 1,500 digital signals in its final configuration:

- Based on the projection, 450 signals per second can change in this system in the worst case.
- If numerous signals with high-precision time stamping are configured in an ET 200M station, for example, when there are 8 SM 321 digital input modules each with 16 inputs, messages can be lost due to the following reasons:
  - Other system-internal messages are generated in addition to the process messages (you can find additional information in the section "AS Process Control Messages for Time Stamp Faults").
  - The following processing levels (interface module, IMDRV_TS blocks, AS message processing, MSG_TS blocks and OS message processing) require more time to evaluate process messages (slow execution cycle of the blocks is set).

Additional information

- Operating Instructions SIMATIC; Distributed I/O Device ET 200M
- Operating Instructions SIMATIC; Distributed I/O Device ET 200iSP

4.4 High-precision time stamping with 1 ms accuracy

Configuration rules

- For high-precision time stamping, use the following digital input module: 6ES7 321-7BHxx-0AB0
  Insert these digital input modules without leaving a gap starting from slot 4.
  Maximum of 8 signal modules with 6ES7 153-2BAx2, 6ES7 153-2BA10, and 6ES7 153-2BA70.
- Synchronize the automation system via a time master, such as SICLOCK TC 400 or a comparable time master.
- Use the following modules in the automation system:
  - Suitable interface module IM 153-2 (see section "Distributed I/O (Page 26")
  - Digital input modules of the ET 200M
- Configure an identical input delay for all digital inputs with high-precision time stamping to a minimum value (100 microseconds).
- Leave the process interrupts deactivated.
- When configuring the plant, ensure that there is no repeater in the signal path between the CPU of the automation system and an ET 200M in the DP master system on which the digital inputs are acquired with high-precision time stamping.
4.4 High-precision time stamping with 1 ms accuracy

- Do not evaluate the digital inputs with high-precision time stamping before the startup time of ET 200M has expired (at least 10 seconds).
- Use appropriate sensors for acquiring the signals.

**Note**

Keep the properties of the sensors in mind. Different transitions of input signals can affect the precision of the time stamping differently. Possible criteria for a different response include:

- Ramp times
- Spikes

**Validity**

The precision of the high-precision time stamping with a precision of 1 ms applies to each DP master system.

**Note**

The precision of the high-precision time stamping between several DP master systems with a precision of 1 ms is **10 ms**.

**Restriction**

The following events may be the cause for temporary degradation of the accuracy of the high-precision time stamping:

- Processing of diagnostic results
- Firmware update
- Reading identification and maintenance information (I&M data)
- Other acyclical services
5.1 Overview: Systems and components

Introduction
This section presents the systems and components required for time stamping of digital input signals.

Systems
The HMI system in the PCS 7 process control system is an operator station. The automation system in the PCS 7 process control system is a SIMATIC station.

Components
The following components are used for converting time stamping of digital input signals:
- SIMATIC station (Page 25)
- Communication modules (Page 26)
- Distributed I/O (Page 26)
- IMDRV_TS block (Page 28)
- EventTS block (Page 29)
- Time master (Page 30)

5.2 SIMATIC station

SIMATIC stations
You can use S7-400 and S7-400H series CPUs in the SIMATIC stations for processing messages and forwarding them to the operator stations.
5.3 Communication modules

Communication modules

You can use the following communication modules for time stamping:

- CP 443-1
- CP 443-5 Extended

**Note**

You can use the PROFIBUS DP connection of the CPU instead of the CP 443-5 Extended.

**Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>CP 443-1</th>
<th>CP 443-5 Extended</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Used as</strong></td>
<td>... interface to the plant bus</td>
<td>... interface to the distributed I/O device</td>
</tr>
<tr>
<td><strong>Used to establish connection between</strong></td>
<td>SIMATIC station and operator station</td>
<td>SIMATIC station and distributed I/O device</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CP 443-5 Extended forwards the stamped messages transferred via the PROFIBUS DP (fieldbus) to the CPU.</td>
</tr>
<tr>
<td><strong>Connection to bus system</strong></td>
<td>Industrial Ethernet (plant bus)</td>
<td>PROFIBUS DP (fieldbus)</td>
</tr>
<tr>
<td><strong>Article number</strong></td>
<td>6GK7 443-1EX20-0XE0</td>
<td>6GK7 443-5DX05-0XE0</td>
</tr>
<tr>
<td></td>
<td>6GK7 443-1EX30-0XE0</td>
<td>6GK7 443-5DX04-0XE0</td>
</tr>
<tr>
<td><strong>Mounting</strong></td>
<td>In the SIMATIC station slots in the rack (universal rack - UR)</td>
<td>In the SIMATIC station slots in the rack (universal rack - UR)</td>
</tr>
</tbody>
</table>

5.4 Distributed I/O

Distributed I/O

Time stamping can be configured with the following distributed I/O devices:

- ET 200M
- ET 200iSP
The following modules are used in the distributed I/O device to acquire signals:

- Interface module for PROFIBUS DP for preprocessing the signals
- Digital input modules for detecting signal transitions

**Note**

**Discontinued modules**

The modules that can currently be ordered are described in this documentation.

The following applies when using modules approved for high-precision time stamping in past versions of PCS 7:

Verify their continued use in PCS 7. You can find additional information on this in the documentation *Process Control System PCS 7: Released Modules*.

### Interface modules for PROFIBUS DP

<table>
<thead>
<tr>
<th>Distributed I/O device</th>
<th>Module</th>
<th>Article number</th>
<th>Product version</th>
<th>Precision</th>
</tr>
</thead>
<tbody>
<tr>
<td>ET 200M</td>
<td>IM 153-2</td>
<td>6ES7 153-2BA02-0XB0</td>
<td>All</td>
<td>1 ms (1)</td>
</tr>
<tr>
<td>ET 200M</td>
<td>IM 153-2</td>
<td>6ES7 153-2BA10-0XB0</td>
<td>All</td>
<td>1 ms (1)</td>
</tr>
<tr>
<td>ET 200M</td>
<td>IM 153-2</td>
<td>6ES7 153-2BA70-0XB0</td>
<td>All</td>
<td>1 ms (1)</td>
</tr>
<tr>
<td>ET 200M</td>
<td>IM 153-2</td>
<td>6ES7 153-2BA82-0XB0</td>
<td>All</td>
<td>1 ms (1)</td>
</tr>
<tr>
<td>ET 200iSP</td>
<td>IM 152-1</td>
<td>6ES7 152-1AA00-0AB0</td>
<td>1.0 (&gt;=2.0 for redundant interfacing)</td>
<td>20 ms</td>
</tr>
</tbody>
</table>

1) up to 8 modules in station 1ms; nine modules and more in station 10 ms
2) for fail-safe signal acquisition 20 ms

### Digital input modules

<table>
<thead>
<tr>
<th>Distributed I/O device</th>
<th>Module</th>
<th>Article number</th>
<th>Used as</th>
</tr>
</thead>
<tbody>
<tr>
<td>ET 200M</td>
<td>SM 321</td>
<td>6ES7 321-7BH01-0AB0</td>
<td>Module for acquisition of process signals: 16 electrically isolated inputs (24 V DC) and diagnostic messages, redundant signal acquisition possible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Precision of 1 ms</td>
<td></td>
</tr>
<tr>
<td>ET 200M</td>
<td>SM 321</td>
<td>6ES7 321-7EH00-0AB0</td>
<td>Module for acquisition of process signals: 16 electrically isolated inputs (24-125 V DC) and diagnostic messages, redundant signal acquisition possible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Precision of 1 ms</td>
<td></td>
</tr>
<tr>
<td>ET 200M</td>
<td>SM 321</td>
<td>6ES7 321-7RD00-0AB0</td>
<td>Module for acquisition of process signals: 4 inputs (NAMUR), suitable for hazardous areas, redundant signal acquisition possible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Precision of 10 ms</td>
<td></td>
</tr>
<tr>
<td>ET 200M</td>
<td>SM 321</td>
<td>6ES7 321-7TH00-0AB0</td>
<td>Module for acquisition of process signals: 16 inputs (NAMUR), redundant signal acquisition possible</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Precision of 10 ms</td>
<td></td>
</tr>
</tbody>
</table>
5.5 IMDRV_TS block

Using the IMDRV_TS block

The IMDRV_TS block is a driver block. IMDRV_TS performs the following tasks for time stamping:

- Transmits time-stamped process signal changes to the Pcs7DiIT block
- Transmits non-specific events (special messages) to the OS

When time stamping is configured for an AS, the "Generate Module Drivers" function inserts IMDRV_TS automatically in a CFC chart (system chart). The names of these CFC charts begins with the "@" character. One IMDRV_TS is inserted for each interface module.

IMDRV_TS reads the messages from the message buffer of an interface module and transfers the time stamp and process signal changes to the EventTS (Page 29) block.

<table>
<thead>
<tr>
<th>Distributed I/O device</th>
<th>Module</th>
<th>Article number</th>
<th>Used as</th>
</tr>
</thead>
<tbody>
<tr>
<td>ET 200M</td>
<td>SM 326</td>
<td>6ES7 326-1BK02-0AB0</td>
<td>Module for acquisition of process signals:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Precision of 20 to 30 ms</td>
<td>- 24 inputs when used</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- with interface module 6ES7 153-2BAx2, 6ES7 153-2BA10, or 6ES7 153-2BA70 and configuration with F-ConfigurationPack V5.5 SP3 or higher</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- 12 inputs (CH 00 to CH 11) for use with interface module 6ES7 153-2BA01</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- redundant signal acquisition and fail-safe signal acquisition possible</td>
</tr>
<tr>
<td>ET 200iSP</td>
<td>SM 131</td>
<td>6ES7 131-7RF00-0AB0</td>
<td>Module for acquisition of process signals:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Precision of 20 ms</td>
<td>8 inputs (NAMUR)</td>
</tr>
</tbody>
</table>

Modules for higher environmental requirements

You can use functionally equivalent SIPLUS modules for higher environmental requirements.

5.5 IMDRV_TS block

Using the IMDRV_TS block

The IMDRV_TS block is a driver block. IMDRV_TS performs the following tasks for time stamping:

- Transmits time-stamped process signal changes to the Pcs7DiIT block
- Transmits non-specific events (special messages) to the OS

When time stamping is configured for an AS, the "Generate Module Drivers" function inserts IMDRV_TS automatically in a CFC chart (system chart). The names of these CFC charts begins with the "@" character. One IMDRV_TS is inserted for each interface module.

IMDRV_TS reads the messages from the message buffer of an interface module and transfers the time stamp and process signal changes to the EventTS (Page 29) block.

<table>
<thead>
<tr>
<th>Distributed I/O device</th>
<th>Module</th>
<th>Article number</th>
<th>Used as</th>
</tr>
</thead>
<tbody>
<tr>
<td>ET 200M</td>
<td>SM 326</td>
<td>6ES7 326-1BK02-0AB0</td>
<td>Module for acquisition of process signals:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Precision of 20 to 30 ms</td>
<td>- 24 inputs when used</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- with interface module 6ES7 153-2BAx2, 6ES7 153-2BA10, or 6ES7 153-2BA70 and configuration with F-ConfigurationPack V5.5 SP3 or higher</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- 12 inputs (CH 00 to CH 11) for use with interface module 6ES7 153-2BA01</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- redundant signal acquisition and fail-safe signal acquisition possible</td>
</tr>
<tr>
<td>ET 200iSP</td>
<td>SM 131</td>
<td>6ES7 131-7RF00-0AB0</td>
<td>Module for acquisition of process signals:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Precision of 20 ms</td>
<td>8 inputs (NAMUR)</td>
</tr>
</tbody>
</table>

Modules for higher environmental requirements

You can use functionally equivalent SIPLUS modules for higher environmental requirements.
System messages

IMDRV_TS reports AS process control message if an error is detected in high-precision time-stamping.

Additional information

Additional information on the diagnostics response of the IMDRV_TS is available in the online help for the PCS 7 Basis Library.

5.6 EventTS block

Note

EventTS and Event16TS blocks

The following information applies to the EventTS and Event16TS blocks. The Event16TS is not mentioned again unless there are any differences to EventTS.

Signal detection with the channel driver block

If blocks from the PCS 7 Advanced Process Library (APL) for input signals are to be given a high-precision time stamp, you must use the following channel driver block for signal detection: Pcs7DiIT.

Using blocks of the Advanced Process Library

The EventTS block is a message block of the APL for signals with high-precision time stamping. Use EventTS to generate time-stamped process messages. Install one of these blocks in a CFC chart if using time stamping.

An alarm block (ALARM_8P) is integrated in both blocks. This alarm block signals a change to the assigned digital input.

Differences between EventTS or Event16TS

- EventTS can send messages from up to 8 digital inputs.
- Event16TS can send messages from up to 16 digital inputs.

Additional information

You can find additional information about the messages and the response of the blocks in the online help for the PCS 7 Advanced Process Library.
5.7 Time master

Time master

The time master distributes the time signal to operator stations and SIMATIC stations that need to be synchronized.

The following time master is recommended for PCS 7:

SICLOCK TC400

- The time master synchronizes connected stations requiring synchronization via Industrial Ethernet/Fast Ethernet.
- The time master can be synchronized using a time signal from a SICLOCK GPS decoder, or SICLOCK DCFRS receiver, for example.

Note
If a third party time master is used, the user must ensure that it has the same accuracy as the SICLOCK 400. It also must be compatible for use in a PCS 7 plant.

Additional information

- You can find information and ordering data on the SICLOCK TM components that can be used in PCS 7 in the ST PCS 7 catalog (add-ons for PCS 7).
- You can find information about time synchronization for a PCS 7 plant in the function manual Process Control System PCS 7; Time Synchronization.
6.1 Overview of configuration steps

Requirement

The components of the automation system are inserted in HW Config. The figure shows an example configuration for time stamping in HW Config:

Overview of configuration steps

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
</table>
| 1    | Configuring the CPs:  
|      | - Configuring the CP 443-1 (Industrial Ethernet) (Page 32)  
|      | - Configuring the PROFINET IO connection of the CPU (Page 34)  
|      | - Configuring the CP 443-5 Extended (Page 35)  
|      | - Configuring the PROFIBUS connection of the CPU (Page 37)  |
| 2    | Configuring the ET 200M station:  
|      | - Power supply (no configuration necessary)  
|      | - Configuring the interface module: IM 153-2/IM 152-1 (Page 40)  
|      | - Digital input modules:  
|      |   - Configuring the SM 321 digital input module (Page 44)  
|      |   - Configuring the SM 131 digital input module (Page 47)  
|      |   - Configuring the SM 326 digital input module (Page 49)  |
| 3    | Configuring the symbols (Page 52)  
| 4    | Configuring the signaling block (Page 54)  
| 5    | Configuring the input signals (Page 54)  
| 6    | Configuring the messages for high-precision time stamping (Page 58)  |
### Configuring the networks

#### 6.2.1 Configuring the networks

The following is described in this section:

- Configuring the CP 443-1 (Industrial Ethernet) (Page 32)
- Configuring a CPU with integrated PROFINET IO connection for connecting to Industrial Ethernet (Page 34)
- Configuring the CP 443-5 Extended (Page 35)
- Configuring the PROFIBUS connection of the CPU (Page 37)

#### Synchronization of the automation system

A master clock is required on the plant bus for the time synchronization of the automation system. We recommend you use the SICLOCK TC400 master clock.

The following options are available for the interface of the automation system to the plant bus:

- Ethernet interface of the CP 443-1
- Integrated PROFINET IO connection of selected CPU types

#### PROFIBUS master

The PROFIBUS master is the component that distributes the system time to the PROFIBUS.

You can use the following components as the PROFIBUS master:

- CP 443-5 Extended
- Internal PROFIBUS connection of the CPU

#### 6.2.2 How to configure the CP 443-1 (Industrial Ethernet)

The following procedure is based on SIMATIC stations connected to Ethernet via CP 443-1.

---

### Additional information

- Online help for *HW Config*
- List *PCS 7 - released modules*

---

<table>
<thead>
<tr>
<th>Step</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Compiling and downloading the AS (Page 59)</td>
</tr>
<tr>
<td>8</td>
<td>Compiling and downloading the OS (Page 59)</td>
</tr>
</tbody>
</table>
If the CPU is connected directly to Ethernet via an integrated PROFINET IO connection, the SIMATIC station is synchronized using NTP. You can find additional information about this in the section "How to assign parameters for the integrated Ethernet connection for a CPU 41x (Page 34)".

**Requirement**

A CP 443-1 is configured in the configuration table for the SIMATIC station (type of CP: See section "Components and Systems > Communication modules (Page 26)").

**Procedure**

1. Select the CP 443-1 in HW Config.
2. Select the menu command **Edit > Object Properties**.
3. In the "Time-of-Day Synchronization" tab, select the "Accept time of day on CP and forward" check box and then select "Automatic".
4. Click "OK" to apply the settings.
6.2.3 How to assign parameters for the integrated Ethernet connection for a CPU 41x

The following procedure is based on SIMATIC stations in which one of the following CPU types is used:

- CPU 41x-5x
- CPU 414-3 PN/DP
- CPU 416-3 PN/DP

We recommend the SICLOCK TC 400 as the time master.

The table below shows the recommended synchronization procedure depending on the interface for time synchronization:

<table>
<thead>
<tr>
<th>Interface for time synchronization</th>
<th>Synchronization method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integrated Ethernet connection of an CPU 41x-5H V6 or higher</td>
<td>NTP method or SIMATIC method</td>
</tr>
<tr>
<td>Integrated Ethernet connection of an CPU 41x</td>
<td>NTP method</td>
</tr>
<tr>
<td></td>
<td>The configuration is described in the following procedure.</td>
</tr>
<tr>
<td>CP 443-1 communication processor</td>
<td>NTP method or SIMATIC method</td>
</tr>
<tr>
<td></td>
<td>For more information on this, refer to section &quot;How to configure the CP 443-1 (Industrial Ethernet) (Page 32)&quot;.</td>
</tr>
</tbody>
</table>

Requirements

- The CPU is connected directly to Ethernet (plant bus).
- The time master is connected to the plant bus.

Procedure

1. Select the CPU in HW Config.
2. Select the menu command Edit > Object Properties.
3. In the "Time-of-Day Synchronization" tab, activate the "Activate NTP time-of-day synchronization" check box.
4. Click "Add". The "Edit NTP Server Address" dialog box opens.
5. Enter the Ethernet address of the time master in the "NTP server address" text box and then click "OK".

6.2.4 How to configure the CP 443-5 Extended

Requirement
A CP 443-5 Extended is configured in the configuration table for the SIMATIC station (type of CP: see section "Components and Systems > Communication Modules (Page 26)").

Procedure
1. Select the CP 443-5 Extended in HW Config.
2. Select the menu command Edit > Object Properties.
3. In the "Operating Mode" tab, activate the "DP master" check box.

4. Select the "Options" tab.

5. Activate the "From station to LAN" option button in the "Time Synchronization" group. The time frames of the time master are then forwarded to the PROFIBUS.

6. Click "OK" to apply the settings.

6.2.5 Rules for configuring the time interval

Configuration of the time interval should be noted in the following cases:

- Configuring the PROFIBUS connection of the CPU (Page 37)
- Configuring the interface module (IM) (Page 40)
Rules for configuring the time interval

The synchronization time interval setting depends on the interface modules (IM 153-2, IM 152-1) that are connected to the DP master systems:

<table>
<thead>
<tr>
<th>Property</th>
<th>Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>IM on the DP master system</td>
<td>If only interface modules (IM) with a variable time interval (such as the IM153-2BA00) are used on the DP master system, set the synchronization time interval of the CPU to e.g. <strong>10 seconds</strong>.</td>
</tr>
</tbody>
</table>
| IMs with the same time interval (fixed or variable) are connected to the DP master system. | Setting for synchronization of the DP slaves:  
  - If all DP slaves on the DP master system expect a time interval of one second for the synchronization, set the time interval for the synchronization for the CPU to e.g. **1 second**.  
  - If all DP slaves on the DP master system expect a time interval of ten seconds for the synchronization, set the time interval for the synchronization for the CPU to e.g. **10 seconds**. |
| IMs with different time intervals (fixed or variable) are connected to the DP master system. | If you use interface modules (IM) with different time intervals on a DP master system, set the minimally required time interval for the respective DP master system (see rule for: IM with same time interval on the DP master system). |

Rules for optimization:

| Multiple synchronization | Avoid multiple synchronization. Set the same interval values for all synchronizations.  
  - Set the time interval for synchronization of the DP slaves.  
  - Set the time interval for the time master that synchronizes the plant. |

### 6.2.6 How to configure the PROFIBUS connection of the CPU

#### Requirement

The S7-400 CPU has been configured in the configuration table.

#### Procedure

1. Select the PROFIBUS connection of the CPU in HW Config.  
2. Select the menu command **Edit > Object Properties**.
3. In the "Operating Mode" tab, activate the "DP master" check box.

![Properties - DP - (R0/S4.1)](image)

4. Select the "Clock" tab.

**Note**

The setting options in the "Clock" tab depend on the interface module (IM) used.
5. Select “As master” in the “Synchronization mode” list. The time frames of the time master are then forwarded to the PROFIBUS.

![Properties DP (R0/S4.1)](image)

**Properties DP - (R0/S4.1)**

<table>
<thead>
<tr>
<th>Synchronization type</th>
<th>Time interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>As master</td>
<td>10 seconds</td>
</tr>
<tr>
<td>None</td>
<td>1 second</td>
</tr>
<tr>
<td>None</td>
<td>10 seconds</td>
</tr>
<tr>
<td>None</td>
<td>1 minute</td>
</tr>
<tr>
<td>None</td>
<td>10 minutes</td>
</tr>
<tr>
<td>None</td>
<td>1 hour</td>
</tr>
<tr>
<td>None</td>
<td>12 hours</td>
</tr>
<tr>
<td>None</td>
<td>24 hours</td>
</tr>
</tbody>
</table>

**Note**

When making a setting from the "Time Interval" drop-down list, keep in mind that the setting options depend on the interface modules (IM) used. Read the section "Rules for configuring the time interval (Page 36)".

6. Click "OK" to apply the settings.
6.3 Configuring the ET 200 station (ET 200M and ET 200iSP)

6.3.1 Setting options of the ET 200 station

Hierarchy of the settings

<table>
<thead>
<tr>
<th>On level ...</th>
<th>... can be set in HW Config</th>
<th>Effect on</th>
<th>Setting option</th>
</tr>
</thead>
</table>
| DP slave (racks) | Properties of the interface module | All digital input modules in an ET 200 station | • Time stamping on/off  
• Positive or negative edge (see section "Examples of settings on interface module IM 153-2 (Page 43)") |
| Module | Properties of the digital input module | All channels of a digital input module | • Time stamping on/off  
• Positive or negative edge (see section "Examples of settings on the digital input module SM 321 (Page 46)") |
| Channel | Properties of the digital input module | An individual channel of a digital input module | • Time stamping on/off  
• Positive or negative edge (see section "Examples of settings on the digital input module SM 321 (Page 46)") |

Note
The lower-level settings are overwritten by activation/passivation of a higher-level instance (e.g. on the DP slave).

6.3.2 How to configure the interface module

Requirements

• A DP master system is configured on a CP 443-5 Extended or on the PROFIBUS connection of the CPU.
• At least one digital input module that supports time stamping is configured in the ET 200 station (type of digital input module: See section "Components and Systems > Distributed I/O (Page 26)").
Setting the synchronization interval

The synchronization interval for the CPU should be set to 10 seconds for PCS 7.

Note

With some modules (for example, article number 6ES7 153-2A...), the synchronization interval for the CPU is fixed at 1 second (increased CPU load).

Procedure

Note

If you want to configure the digital input modules individually, open the object properties for the respective digital input modules.

Additional information:

- "How to configure the SM 321 digital input module (Page 44)" section.
- "How to configure the SM 131 digital input module (Page 47)" section.

1. Select the interface module in HW Config.
2. Select the menu command Edit > Object Properties.
3. In the “Name” input box on the “General” tab, enter a unique name for the interface module. A unique name makes it easier to assign program blocks in other configuration tasks and messages.

4. Open the “Time Synchronization” tab.

5. Activate the “Time synchronization” check box. If possible, select the optimum synchronization interval.

   **Note**

   When selecting the synchronization interval, note the “Rules for configuring the time interval (Page 36)” section.

6. Open the “Time-of-day Stamp” tab.

   **Note**

   The “Time-of-Day Stamp” tab is available in the “Object Properties” dialog box for the interface module only if you have configured at least one digital input module that supports time stamping in the ET 200 station (see “Setting options on the ET 200 station” (Page 40)).

7. Select the “Time-of-day stamp” check box in the “Presetting of All Inputs” group.
8. Specify the edge of the process signal from the IM that should be interpreted as an "incoming event". The opposite signal transition is interpreted as the signal exiting the state. Select the check box for the required signal change:
- "Falling Edge 1 -> 0" or
- "Rising Edge 0 -> 1"
When the static state of a signal changes, a message is generated at this point in time.

9. Click "OK" to apply the settings.

---

**Note**
The settings in the "DP Slave Properties" dialog box apply to all channels of the digital input modules with time stamping used in this ET 200 station. A change in the "Presetting of All Inputs" field affects the settings for all inputs of this ET 200 station.

---

### 6.3.3 Examples of settings on interface module IM 153-2

**1st example**

IM 153-2 - time stamping for the entire ET 200M station activated (or only one module with time stamping in this ET 200M station):

![DP Slave Properties](image)
2nd example

IM 153-2 - time stamping for the ET 200M station passivated:

![DP slave properties](image)

3rd example

IM 153-2 - time stamping for (individual) modules or (individual) channels activated:

![DP slave properties](image)

6.3.4 How to configure the SM 321 digital input module

**Note**
You only need to read this section if you want to set time stamp for each digital input module separately.
Requirements

- At least one ET 200M station is configured in HW Config.
- A digital input module SM 321 is configured in at least one slot of the ET 200M station (IM 153-2) (type of digital input module: See section "Components and Systems > Distributed I/O (Page 26)").

Procedure

1. In the ET 200M station, select the SM 321 digital input module for which you want to make the settings.
2. Open the shortcut menu (right-click) and select the menu command Object Properties.
3. Activate the "Time stamp" check box in the "Time stamping" tab and activate the radio button you want for RLO edge detection.

Additional information

- "Examples of settings on digital input module SM 321 (Page 46) " section
- Section "How to configure the interface module (Page 40)"
6.3.5 Examples of settings on digital input module SM 321

1st example

Setting on the module - presetting of all inputs activated:

![Properties - DI16xDC24V, Interrupt - (R-/S4)](image1)

2nd example

Setting on the module - channel-specific individual assignment of the inputs activated:

![Properties - DI16xDC24V, Interrupt - (R-/S4)](image2)
6.3.6 How to configure the SM 131 digital input module

Note
You only need to read this section if you want to set time stamp for each digital input module separately.

Requirements

- An ET 200iSP station is configured in HW Config.
- A digital input module SM 131 (8 DI NAMUR) is configured in at least one slot of the ET 200iSP station (IM 152-1) (type of digital input module: See section "Components and Systems > Distributed I/O (Page 26)").

Procedure

1. In the ET 200iSP station, select the SM 131 digital input module for which you want to make the settings.
2. Open the shortcut menu (right-click) and select the menu command Object Properties.
3. Select the "Parameters" tab.
4. In the tree view, select the folder Parameters > Time Stamp > Individual setting of the inputs.
5. In the tree view, open the folder of the channel to be changed (for example, channel 0)

6. Open the "Time stamping" parameter in the tree view. Activate the check box in the "Value" column.

7. Open the "Edge Evaluation Incoming Event" parameter in the tree view. Select the direction of the edge evaluation from the drop-down list box in the "Value" column.

**Note**

You now need to configure each input separately.

Configuration via the interface module affects all inputs of the digital input module in this ET 200iSP station.

8. Click "OK".

The settings are applied.

Additional information

- Section "Example of setting on digital input module SM 131 (Page 48)"
- Section "How to configure the interface module (Page 40)"

6.3.7 Examples of settings on digital input module SM 131

The settings can be made for all modules or specific channels.
Example

Setting on the module:

![Properties - 8 DINAMUR - (R-/S4)](image)

6.3.8 How to configure the SM 326 digital input module

**Note**
You only need to read this section if you want to set time stamp for each digital input module separately.

Influence on a configured F system

**Note**
The activation of the high-precision time stamping has no effect on the operation of an F system if the required modules and inputs have already been configured.
Inputs available

The number of digital input module inputs available for time stamping depends on the following supplementary conditions:

- Version of the software package: SIMATIC S7; F-ConfigurationPack
- Type of IM 153-2 interface module

High-precision time stamping is only available in fail-safe signal modules of the SIMATIC S7-300 if you are using IM 153-2 interface modules with the following article numbers:
- 6ES7 153-2BAx1-0XB0
- 6ES7 153-2BAx2-0XB0
- 6ES7 153-2BA10-0XB0
- 6ES7 153-2BA70-0XB0

<table>
<thead>
<tr>
<th>Software packages</th>
<th>Interface module 6ES7 153-2BAx1-0XB0</th>
<th>Interface modules 6ES7 153-2BAx2-0XB0 6ES7 153-2BA10-0XB0 6ES7 153-2BA70-0XB0</th>
</tr>
</thead>
<tbody>
<tr>
<td>F-ConfigurationPack V5.4 SP1 to V5.5 (S7 F-Systems V5.2 SP4)</td>
<td></td>
<td>High-precision time stamp not available</td>
</tr>
<tr>
<td>F-ConfigurationPack V5.5 SP1 and V5.5 SP2 (S7 F-Systems V5.2 SP4)</td>
<td>12 channels available (CH00 to CH11)</td>
<td></td>
</tr>
<tr>
<td>F-ConfigurationPack V5.5 SP3 or higher (S7 F-Systems V6.0)</td>
<td>12 channels available (CH00 to CH11)</td>
<td>24 channels available (CH00 to CH23)</td>
</tr>
</tbody>
</table>

Requirements

- An ET 200M station is configured in HW Config.
- A digital input module SM 326 is configured in a slot of the ET 200M station (IM 153-2) (type of digital input module: See section "Components and Systems > Distributed I/O (Page 26) ").

Procedure

1. In the ET 200M station, select the SM 326 digital input module for which you want to make the settings.
2. Open the shortcut menu (right-click) and select the menu command Object Properties.
3. Select the "Parameters" tab.
4. In the tree view, select the folder Parameters > Time Stamping > Individual setting of the inputs.
5. In the tree view, open the folder of the channel to be changed (for example, channel 0)
6. Open the "Time stamping" parameter in the tree view. Activate the check box in the "Value" column.
7. Open the "Edge Evaluation Incoming Event" parameter in the tree view. Select the direction of the edge evaluation from the drop-down list box in the "Value" column.

**Note**

You now need to configure each input separately.

Configuration via the interface module affects all inputs of the digital input module in this ET 200M station.

8. Click "OK".

The settings are applied.

**Additional information**

- Section "Examples of settings on digital input module SM 326 (Page 51)"
- Section "How to configure the interface module (Page 40)"

**6.3.9 Examples of settings on digital input module SM 326**

The settings for each module must be made for specific channels. Configuration via the interface module affects all inputs of the digital input module in this ET 200M station.
Example

Setting on the module:

![Properties - DI24xDC24V - (R-/S8)](image)

### 6.4 Configuring the symbolic names

#### 6.4.1 How to configure symbolic names for signals

**Introduction**

You can assign symbolic names for the signals. Simple identification of the signals makes it easier to interconnect the driver blocks.
Requirements

- The project is open in SIMATIC Manager in the **component view**.
- The path to the AS is set.
- HW Config is open.

Procedure

Execute the following steps for all digital input modules:

1. Select a digital input module in HW Config.
2. Select a row in the configuration table of the module in which an address of the process image is assigned.
3. Select the menu command **Edit > Edit symbols**.
4. Enter the symbols (symbolic names) for the allocated inputs of the modules with time stamping.
   You can activate the takeover of the addresses as symbols with the button "Add symbol".
   You can change the symbol name either in the "Edit symbols" dialog box or in the symbol table (e.g. Symbol = "Chart_Measurement" - a maximum of 24 characters is permitted).

<table>
<thead>
<tr>
<th>Address</th>
<th>Symbol</th>
<th>Data type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Input 0.0</td>
<td>BOOL</td>
<td>Input 1</td>
</tr>
<tr>
<td>2</td>
<td>E0.1</td>
<td>BOOL</td>
<td>Input 2</td>
</tr>
<tr>
<td>3</td>
<td>E0.2</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>E0.3</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>E0.4</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>E0.5</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>E0.6</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>E0.7</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>E1.0</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>E1.1</td>
<td>BOOL</td>
<td></td>
</tr>
<tr>
<td></td>
<td>E1.2</td>
<td>BOOL</td>
<td></td>
</tr>
</tbody>
</table>

You can activate the takeover of the addresses as symbols with the button "Add symbol". You can change the symbol name either in the "Edit symbols" dialog box or in the symbol table (e.g. Symbol = "Chart_Measurement" - a maximum of 24 characters is permitted).
6.5 Configuring the message block

6.5.1 How to prepare the message configuration

You must configure an EventTS block in CFC charts so that messages with high-precision time stamps can be displayed on the OS. The EventTS block can generate the messages for up to 8 digital inputs.

Procedure

Create a CFC chart with a message block.

6.6 Configuring the input signals

6.6.1 How to configure the input signals

Procedure

1. Select the "PV_In" input of the channel driver block Pcs7DiIT in the CFC chart.
2. Select the menu command Insert > Interconnection to Address. The "Insert Interconnection to Address" dialog box opens.
3. Select the row with the corresponding module input and double-click in the row.

```
<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>10.1</td>
<td>BOOL</td>
<td>I</td>
<td>0.1</td>
</tr>
<tr>
<td>10.2</td>
<td>BOOL</td>
<td>I</td>
<td>0.2</td>
</tr>
<tr>
<td>10.3</td>
<td>BOOL</td>
<td>I</td>
<td>0.3</td>
</tr>
<tr>
<td>10.4</td>
<td>BOOL</td>
<td>I</td>
<td>0.4</td>
</tr>
<tr>
<td>10.5</td>
<td>BOOL</td>
<td>I</td>
<td>0.5</td>
</tr>
<tr>
<td>10.6</td>
<td>BOOL</td>
<td>I</td>
<td>0.6</td>
</tr>
<tr>
<td>10.7</td>
<td>BOOL</td>
<td>I</td>
<td>0.7</td>
</tr>
</tbody>
</table>
```

4. Connect the blocks as shown for the connections in the following examples.

**Note**

You can configure messages assigned to the module input directly at the signaling block when you configure an input signal, or you can configure them later. You can find additional information in the section "Configuring the messages for the high-precision time stamping (Page 58)".

**Note**

**Configuration for an F system**

Position the EventTS block in a CFC chart that is not in the runtime group of the F blocks. It is not possible to forward time stamps to technology blocks via the channel driver blocks of the F libraries.

**Note**

**EventTS and Event16TS blocks**

The following information applies to the EventTS and Event16TS blocks. The Event16TS is not mentioned again unless there are any differences to EventTS.

**Example of configuration with a technology block**

**Note**

**Making the inputs visible**

You must make the following inputs of the technology blocks visible:

**EventTS block**

- "TimeStampOn" input
  
  This input activates the high-precision alarm inputs when the value = 1.

- Input "InTS<xx>"
  
  When technological blocks are used, these inputs are additionally interconnect to the inputs of the technological blocks.
The following figure provides an example of high-precision time stamping for the "FbkRun" input of the "MotL" block.

- **EventTS block**: Input "TimeStampOn" = 1

- The following I/Os are interconnected:
  - Module, "I1.0" input with the "PV_In" input of the Pcs7DiIT channel driver block
  - "PV_Out" output of the Pcs7DiIT channel driver block with the "FbkRun" input of the MotL block.
  - "TS_Out" output of the Pcs7DiIT channel driver block with "InTS1" input of the EventTS block.
  - EventTS block: "EventTsOut" output with the MotL block, "EventTsIn" input.

The message should be configured at the EventTS block. Replace the default text ($$BlockComment$$ InTS1 Status 16#@1%x@) with a project-specific message text. Example: $$BlockComment$$ <runtime error> Status 16#@1%x@

Example of configuration with the EventTS block

The following figure provides an example of high-precision time stamping for the "I1.0" of a digital input module.

- EventTS block: Input "TimeStampOn" = 1
The following I/Os are interconnected:

- "I1.0" input of the module with the "PV_In" input of the Pcs7DilT block
- "TS_Out" output of the Pcs7DilT block with the "InTS1" input EventTS block
- The message should be configured at the EventTS block. Replace the default text ($$BlockComment$$ InTS1 Status 16#@1%x@) with a project-specific message text. Example:$$BlockComment$$ <temperature high> Status 16#@1%x@

Notes on configuration with redundant signal acquisition

Take into account the following information for a configuration with redundant signal acquisition:

- It is possible to mix redundant and non-redundant DI signals.
- With redundant signal acquisition, a message is produced for the OS for each module input regardless of the module status (passivated, good status).

Additional information

You can find more information on configuration with redundant signal acquisition in the documentation Process Control System PCS 7; Fault-Tolerant Process Control Systems.
6.7 Configuring the messages for the high-precision time stamping

6.7.1 How to configure messages with blocks of the PCS 7 Advanced Process Library (APL)

Introduction

This section explains how to change the message texts at the APL block EventTS.

Procedure

1. Open the project in SIMATIC Manager and select the menu command View > Component View.
2. Select the chart folder of a S7 program in the tree: Project\SIMATIC Station\CPU\S7 Program\Charts.
3. Select the menu command Options > Charts > Chart Reference Data. The "Chart Ref: Display Chart Reference Data" dialog box opens.
4. Select the menu command View > Block Types. The "{S7 Program} (Block Types)" dialog box opens.
5. Click "Block type" in the table heading. The entries are sorted alphabetically.
6. Find the EventTS block with the associated entries in the list.
7. Double-click on the block type of the messaging block in the table row found. The CFC chart containing the block you are searching for opens. The relevant block is highlighted.
8. Select the menu command Edit > Object Properties. The "Properties – Block" dialog box opens.
9. Click "Messages" in the "Special Properties" group. The "PCS 7 Message Configuration" dialog box opens.
10. Select the message class of the message. Change the message text in the "Event" column of the table (see example).
11. Click "OK".

Example

Replace the default text ({$$BlockComment$$ InTS1 Status 16#@1%x@}) with the project-specific message text (for example, {$$BlockComment$$ <temperature high> Status 16#@1%x@}).

Additional Information

You can find additional information about message configuration in the STEP 7 online help under the topic "How to Create Block-Related Messages for the Project".
6.8 Compiling and downloading the AS

6.8.1 How to compile and download the AS

Options

The following options are available for compiling and downloading programs:

- You can use the commands for a single SIMATIC station.
- You can compile and download multiple SIMATIC stations with a single command.

Additional information

You can find additional information and step-by-step instructions in the configuration manual *Process Control System PCS 7; Engineering System*.

6.9 Compiling and downloading the OS

6.9.1 How to compile and download the OS

Options

The following options are available for compiling and downloading the operator station(s):

- You can compile and download operator stations one-by-one.
- You can compile several operator stations at the same time and download them on their own.
- You can compile and download several operator stations at the same time.

Additional information

You can find additional information and step-by-step instructions in the configuration manual *Process Control System PCS 7, Operator Station*.
Configuring time stamping

6.9 Compiling and downloading the OS
7 AS process control messages for time stamping faults

7.1 Time stamping fault

Introduction

This section describes the AS process control messages that are generated when faults occur in the time stamping.

Overview of AS process control messages

The following AS process control messages can be generated for time stamp faults:

- Startup data (Page 61)
- Time frame failure (Page 63)
- Time difference between the frame and internal clock may cause inaccuracy (Page 63)
- STOP of the time stamping function (Page 64)
- Message loss at IM (buffer overflow) (Page 65)
- Redundant changeover (Page 65)
- Loss of information with redundancy (Page 66)

Additional information

Additional information about editing the message texts is available in the section "Configuring time stamping > Configuring messages for high-precision time stamping" > How to configure messages with blocks of the PCS 7 Advanced Process Library (APL) (Page 58).

7.2 AS process control message "Startup data"

Meaning

The AS process control message "Startup data" indicates a start/restart of the interface modules (for example, IM 153-2).

Messages

- "Startup data" with the signal status "INCOMING"
- "Startup data" with the signal status "OUTGOING"
Description

1. After the start/restart, the interface module sends the signal for the AS process control message "Startup data" with the signal status "INCOMING" to the CPU.

2. The interface module then sends messages signaling the static state of all configured process signals. Based on the process signal, the interface module derives the signal to be sent according to the configuration (see following table).

3. Following this, the interface module sends the signal for the AS process control message "Startup data" with the signal status "OUTGOING".

<table>
<thead>
<tr>
<th>Status process signal</th>
<th>Configured edge evaluation of incoming event:</th>
<th>Interface module (signal message from startup)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0 -&gt; 1</td>
<td>OUTGOING</td>
</tr>
<tr>
<td>1</td>
<td>0 -&gt; 1</td>
<td>INCOMING</td>
</tr>
<tr>
<td>1</td>
<td>1 -&gt; 0</td>
<td>OUTGOING</td>
</tr>
<tr>
<td>0</td>
<td>1 -&gt; 0</td>
<td>INCOMING</td>
</tr>
</tbody>
</table>

Message derived from the process signal (depending on configuration)

Message processing in PCS 7

1. The signal for "Startup data" with the signal status "INCOMING" is detected and the AS process control message "Startup data" is entered in the message list with the signal status "INCOMING".

2. In the CPU, the message block compares the signal messages representing the static state of the process signals with the last stored state of the signals. If there are signals whose states are different, messages are entered in the message list (see following table):

3. The OS identifies the signal for the startup data. The AS process control message "Startup data" is entered in the message list with the signal status "OUTGOING".

<table>
<thead>
<tr>
<th>Interface module (signal message from startup)</th>
<th>Value stored in the CPU (message block)</th>
<th>Message in message list and archive</th>
</tr>
</thead>
<tbody>
<tr>
<td>INCOMING</td>
<td>INCOMING</td>
<td>----</td>
</tr>
<tr>
<td>INCOMING</td>
<td>OUTGOING</td>
<td>OUTGOING</td>
</tr>
<tr>
<td>OUTGOING</td>
<td>OUTGOING</td>
<td>----</td>
</tr>
<tr>
<td>OUTGOING</td>
<td>INCOMING</td>
<td>INCOMING</td>
</tr>
</tbody>
</table>

Possible status of a message in the message list
7.3 AS process control message "Time frame failure"

Meaning

The AS process control message "Time frame failure" indicates a failure of the time synchronization of the interface module (for example, IM 153-2).

Messages

- "Time frame failure" with signal status "INCOMING"
- "Time frame failure" with signal status "OUTGOING"

Description

The interface module expects a time frame from the time master at the set interval (e.g. every second).

When the time frame fails three consecutive times, the interface module continues working with the internal time and sends the message "Time frame failure" with the signal status "INCOMING" to the operator station.

The internal clock of the interface module is synchronized after the next valid time frame has arrived, and the message "Time frame failure" is triggered with the signal status "OUTGOING".

7.4 AS process control message "Time difference between frame and internal clock may cause inaccuracy"

Meaning

The AS process control message "Time difference between frame and internal clock may cause inaccuracy" indicates a time jump/time difference in the interface module (e.g. IM 153-2).

Messages

- "Time difference between frame and internal clock may cause inaccuracy" with the signal status "INCOMING"
- "Time difference between frame and internal clock may cause inaccuracy" with the signal status "OUTGOING"
Both messages are sent consecutively when the following applies:

- There is a difference between the synchronous time and the internal time of the interface module when a signal is received by the interface module.
- The difference between the times is greater than half the accuracy of the time stamp. Example: For a time stamp accuracy of 10 ms, the difference is > 5 ms.
  - The time of the interface module is synchronized afterwards.
  - The message with the signal status "INCOMING" receives the time stamp prior to the synchronization.
  - The message with the signal status "OUTGOING" receives the time stamp after the synchronization.

This means you can determine if the internal clock of the interface module was set forward or back.

### 7.5 AS process control message "STOP of the time stamping function"

#### Meaning

The AS process control message "STOP of the time stamping function" indicates a fault in the interface module (for example, IM 153-2).

#### Messages

- "STOP of the time stamping function" with the signal status "INCOMING"
- "STOP of the time stamping function" with the signal status "OUTGOING"

#### Description

When the connection between the DP master and the interface module stops, the time stamping of the signals is stopped. This is the case, for example, when the CP fails or the bus cable is interrupted. A message to this effect is entered in the internal message list.

- The time stamping of the signals is stopped from the moment the message with the signal status "INCOMING" is generated.
- The time stamping of the signals becomes active again after the message with the signal status "OUTGOING".
- After the message "STOP of the time stamping function" with the signal status "OUTGOING", the interface module starts up again.
7.6 AS process control message "Message loss at IM (buffer overflow)"

Meaning

The AS process control message "Message loss at IM (buffer overflow)" indicates a loss of messages due to an overflow of the message buffer of the interface module.

Messages

- "Message loss at IM (buffer overflow)" with the signal status "INCOMING"
- "Message loss at IM (buffer overflow)" with the signal status "OUTGOING"

Description

The AS process control message is generated in the two following situations:

<table>
<thead>
<tr>
<th>Buffer overflow due to external causes</th>
<th>Buffer overflow due to internal causes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Examples of potential causes:</td>
<td>Example of a potential cause:</td>
</tr>
<tr>
<td>• Failure or overload of the plant or field bus</td>
<td>The signals in the I/O change so quickly that the</td>
</tr>
<tr>
<td>• Failure or overload of the DP master (CPU)</td>
<td>signal transitions can no longer be entered in the</td>
</tr>
<tr>
<td>Remedy: Correct the source of the problem</td>
<td>message lists.</td>
</tr>
<tr>
<td></td>
<td>Remedy: Distribute the signals over several interface modules or reduce the number of signals with time stamping.</td>
</tr>
</tbody>
</table>

A message to this effect is entered in the internal message list.

- Incoming messages cannot be saved from the moment the message with the signal status "INCOMING" is generated.
- Incoming messages can be saved again once the message with the signal status "OUTGOING" has been generated.

7.7 AS process control message "Redundant changeover"

Meaning

The AS process control message "Redundant changeover" is generated when there is a switch between the active and passive interface module (e.g. IM 153-2).

Messages

- "Redundant changeover" with the signal status "INCOMING"
- "Redundant changeover" with the signal status "OUTGOING"
7.8 AS process control message "Loss of information with redundancy"

Meaning

The AS process control message "Loss of information with redundancy" indicates an error when signals are exchanged between the passive interface module (for example, IM 153-2) and the active interface module.

Messages

- "Loss of information with redundancy" with the signal status "INCOMING"
- "Loss of information with redundancy" with the signal status "OUTGOING"

Description

During error-free operation, the passive interface module receives information about the current state of the I/O from the active interface module:

- There is a signal exchange error from the moment the message with the signal status "INCOMING" is generated.
- As soon as the I/O state has been synchronized between the active and passive interface modules, the message with the signal status "OUTGOING" is output.
Index

A
Advanced Process Library, 29
APL, 29
AS, 59
  compiling and downloading, 59
AS process control messages, 61, 63, 64, 65
  Loss of information with redundancy, 66
  Message loss at IM (buffer overflow), 65
  Redundant changeover, 65
  Startup data, 61
  STOP of the time stamping function, 64
  Time difference between frame and internal clock may cause inaccuracy, 63
  Time frame failure, 63

C
Communication
  to operator station, 25
Communication modules, 26
  CP 443-1, 26
  CP 443-5 Extended, 26
  For time stamping, 26
Compile, 59
AS, 59
OS, 59
Configuration, 19, 52, 54
  EventTS, 56
  Input signals, 54
  Note, 19
  Redundancy, 57
  Symbols, 52
  Technology block, 55
Configuring, 32, 33, 35, 37, 40, 44
  CP 443-1 Industrial Ethernet, 33
  CP 443-5 Extended, 35
  CPs, 32
  Digital input module SM 321, 44
  Interface module IM 153-2, 40
  PROFIBUS connection of the CPU, 37
  CP 443-1 Industrial Ethernet, 33
  Configuring, 33
  CP 443-5 Extended, 35
  Configuring, 35
  CPs, 32
  Configuring, 32

D
Digital input module SM 131, 49
  Configuring, 47, 49
Digital input module SM 321, 44, 46
  Configuring, 44
  Settings, example, 46
Digital input module SM 326, 52
  Configuring, 49, 52
Digital input modules, 27
Distributed I/O
  for signal acquisition, 26
  Supported modules, 26
Download, 59
AS, 59

E
Environmental requirements
  Higher, 28
ET 200iSP, 47, 49
  Digital input module example, 49
  SM 131 Example, 49
  SM131, 47
ET 200M, 49, 52
  Digital input module example, 52
  SM 326 Example, 52
  SM326, 49
ET 200M station, 40
  Settings for time stamping, 40
EventTS block
  Note, 29
Examples, 20, 43, 46
  Plant with time stamping, 20
  Redundant plant with time stamping, 20
  Settings for interface module IM 153-2, 43
  Settings on digital input module SM 321, 46

F
Faults, 61
  in time stamping, 61

H
High-precision time stamping with 1 ms precision, 23
I
IM 153-2, 22
  Message loss, 22
  Signal surge, 22
  Special features, 22
IMDRV_TS block
  Note, 29
    using for time stamping, 28
Input signals, 54
  Configuration, 54
Interface module IM 153-2, 40, 43
  Configuring, 40
    Examples of settings, 43
Interface modules, 27

L
Loss of information with redundancy, 66

M
Message loss, 22
IM 153-2, 22
Messages, 61, 63, 64, 65
  Fault in time stamping, 61
  Loss of information with redundancy, 66
  Message loss at IM (buffer overflow), 65
  Redundant changeover, 65
Startup data, 61
STOP of the time stamping function, 64
  Time difference between frame and internal clock
    may cause inaccuracy, 63
    Time frame failure, 63

O
Operator station
  Communication to CPU, 25
OS, 59
    Compile, 59

P
Plant with time stamping, 20
  Example, 20
Precision
  Time stamping, 11
Preface, 7

R
Redundancy, 57
  Redundant changeover, 65
    AS process control message, 65
Redundant plant with time stamping, 20
    Example, 20

S
Sequence, 13
  Time stamping, 13
Settings, 43, 46
  Digital input module SM 321, examples, 46
    Interface module IM 153-2, examples, 43
Signal acquisition
  Supported modules, 26
    Via distributed I/O, 26
Signal surge, 22
  On the IM 153-2, 22
Signals, 52
  assigning symbolic names, 52
SIPLUS modules, 28
SM 131, 49
  Example, 49
SM 326, 52
  Example, 52
Startup data, 61
  AS process control message, 61
STOP of the time stamping function, 64
  AS process control messages, 64
Symbolic names, 52
  Assigning signals for, 52
Symbols, 52
  Configuration, 52
System planning, 19
  Note, 19

T
Time difference between frame and internal clock
  may cause inaccuracy, 63
  AS process control message, 63
Time frame failure, 63
  Messages, 63
Time master, 30
Time stamping, 20, 26, 40, 61
  Communication modules, 26
CPU used, 25
Functionality, 11
Messages for faults, 61
Plant configuration, 20
Precision, 11
Requirements, 11
Resolution, 11
Sequence, 13
Settings on the ET 200M station, 40
using, 11
Using the IMDRV_TS block, 28
Time stamping (10 ms), 11
Time Stamping in the Interface Module, 15

U
Using
IMDRV_TS block for time stamping, 28
Time stamping, 11
Index

High-precision time stamping (V8.2)

Function Manual, 03/2016, A5E36186939-AA